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Welcome 

Please read this document carefully; it contains important information about PC Tools for 
Windows Version 2. For easiest reading, enlarge this window by clicking the Maximize button,
or print this document for future reference.

PC Tools for Windows is a Window-based suite of utilities and does not include the DOS 
versions of PC Tools applications, except those required by the Emergency Disk application.

IMPORTANT NOTICE: PCTW places several dynamic linked library files (DLL's) into the 
Windows directory during installation. The files are removed automatically after a successful 
installation. If, however, for any reason the install process fails or is stopped, delete the 
following files from the Windows directory before running the Install program again: 

CPAVDLG.DLL
CPAVSCAN.DLL
WNCPS2.DLL
WNFSV2.DLL.

System Requirement Notes

■ Files on Installation Disks.  All files that have the underscore character as the last 
character of the extension are compressed files (using PKZIP 2.x compatible 
compression method). You can expand these files by typing this at the command line:

PKUNZIP filename.ex_ [destination directory]   

■ DES Encryption.  The DES encryption wndes2.dll is not included with PC Tools for 
Windows.  The encryption will be posted on the Central Point Bulletin Board System 
(BBS).  Refer to the back cover of your PC Tools for Windows manual for information on 
contacting Central Point's BBS.

■ Enhancing Performance.  If you have more than 4 MB of memory on your system, you 
can significantly improve the performance of PC Tools for Windows by setting aside 1 MB
of Windows disk cache.  If you have 4 MB or less, use 256 - 512K as your disk cache.  
For example, if you are using SMARTDrive and have 4 MB of memory on your system, 
you could specify a disk cache between 256K and 512K and add this line to your 
AUTOEXEC.BAT file:   

SMARTDRV.EXE 1024 384

■ Standard Operating Systems and Networks.  PC Tools for Windows is designed for 
optimal use with Microsoft Windows Version 3.1 enhanced mode under MS DOS, and for 
networking on Novell NetWare Version 2.x or 3.x systems.  Microsoft does not support 
Novell's network shell program EMSNETX in enhanced mode, and this can result in 



system lockups and errors. PC Tools for Windows enhances many low-level and high-
performance features of these systems.  If you use other products that are not fully 
compatible with MS DOS, or run Windows in standard mode, you may encounter reduced
performance or functional errors.  If you use a network other than Novell NetWare 
Version 2.x or 3.x, some PC Tools for Windows features are not available. 

■ Bindery Information with NetWare 4.0.  The bindery information will not be available in 
File Manager, System Consultant, or Backup under NetWare 4.0 unless the Bindery 
emulation is installed.

■ Video Drivers.  Some older versions of video drivers can result in a variety of problems 
in any Windows application.  These problems can include application errors, General 
Protection Faults, and video display corruption.  In most cases, you can correct these 
problems by using the most current version of video drivers available.  To change video 
drivers, use the Windows Setup program to replace the display driver with one of the 
Windows default drivers.  For information on newer versions of your video driver, contact 
the manufacturer.  

Older versions of the following drivers are known to cause problems occasionally:

ATI 68800 Processor Video Drivers, including:
ATI Graphics Ultra Pro EISA, ISA, and Local Bus (Mach 32 or Crystal Fonts)
ATI Ultra
ATI VGA Wonder
Acer Local Bus Graphics Accelerator
Gateway 68800 Local Bus
CornerStone Dual Page 120 for ISA or MCA Driver, Version 2.04B
Diamond SpeedStar, SpeedStar 24X, Stealth VRAM Drivers
Number Nine GXE
Orchid F1280 Fahrenheit Drivers
Pro Audio Studio Video (3/23/93)
TVGA 8900C
Video Seven WinVGA Drivers
WinSpeed Display Drivers

Compatibility Notes

NOTE  The compatibility issues documented in this section are either inherent in the design 
of the product specified, in the underlying technology, or require a modification by the 
product's manufacturer.  If you encounter a problem using a product other than those listed, 
try to isolate the cause of the problem before calling Central Point technical support.  One by 
one, remove any applications or drivers not supplied with Microsoft Windows and try using 
PC Tools for Windows again.  We appreciate any information you can supply that might help 
us solve your problem and alert other users to potential compatibility issues.

■ Windows for Workgroups Version 3.11.  DiskFix, Optimizer, and the Undelete 
command in File Manager will not operate with the 32-bit file access setting enabled.  In 
addition, the delete protection method Sentry will not operate with 32-bit file access 
enabled.

■ After Dark or the Star Trek Edition.  Versions of these screen savers earlier than 
Versions 2.0c can cause icon color and drawing problems, application errors, and 
General Protection (GP) faults in any Windows application.  If you experience any of 
these problems, use one of the screen savers provided with Windows or PC Tools for 
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Windows.  Contact Berkeley Systems, Inc. Technical Support for information on newer 
versions of their screen savers that remedy these problems.  In addition, avoid moving 
the hidden window of After Dark in Desktop Manager.

■ Bitfax for Windows Version 2.05.  To install Bitfax for Windows Version 2.05, ensure 
Program Manager is running.

■ Compton's Interactive Encyclopedia.  There are incompatibilities with older versions of
Compton's install program and Desktop.  The SETUP.EXE program for Compton's 
Interactive Encyclopedia Version 1.01 might fail, as well as other Compton products such 
as Pill Box.  You can manually run the programs that SETUP.EXE calls by typing this at 
the command line:  

SETUPCD.EXE and SETUPVFW.EXE.

Compton's Encyclopedia window does not resize properly and occasionally might cause 
a GP fault when used with Desktop.  Versions 1.01 VW and later have resolved this 
problem.  To get a software correction, call Compton's technical support at (619) 929-
2626.

■ Da Vinci E-mail Version 1.70b or earlier.  Desktop keyboard shortcuts do not work 
while this electronic mail software is active.  If you experience this problem, exit from Da 
Vinci E-mail, then use the Desktop keyboard shortcuts as necessary.  For information on 
newer versions of Da Vinci E-mail, contact Da Vinci Systems Customer Service.

■ Disk-Compression Software.  The manufacturers of most disk-compression software 
recommend against running any third-party disk utilities on their compressed disk drives. 
Do not use Optimizer or DiskFix when a manufacturer recommends against use of third-
party utilities.  If you are uncertain about the manufacturer's recommendation, contact 
their Technical Support group for specific recommendations or back up the entire physical
drive before attempting to use Optimizer or DiskFix.

■ Facelift for Windows Version 2.  To install Facelift for Windows Version 2, ensure that 
Program Manager is your shell.

■ IconHearIt.  This product can cause system instabilities if run without Program Manager. 
If you want to use Desktop as your shell, make sure you include Program manager 
(PROGMAN.EXE) in your Startup folder to load prior to IconHearIt.

■ Intermission Version 3.  The import feature in this version of Intermission is not 
compatible with PC Tools for Windows Screen Savers.  For information on newer 
versions of Intermission, contact ICOM Simulations Customer Support.

■ Lotus Server Notes.  If you are using Lotus Server Notes, the Lotus Server Notes 
application opens each time you switch between Desktops. Enable Tag Along for your 
Lotus Server Notes to correct this problem.

■ LANtastic Networks.  Local drives shared on a LANtastic network cannot be scanned by
Central Point Anti-Virus, optimized using Optimizer, or analyzed using DiskFix.  To 
perform these functions on a shared LANtastic drive, edit the LANtastic STARTNET.BAT 
file, removing the SERVER command.  Then, restart (reboot) your computer and use 
Central Point Anti-Virus, Optimizer, or DiskFix as needed.  When you have finished 
scanning, optimizing, or analyzing the drive, edit the LANtastic STARTNET.BAT file again,

PC Tools for Windows Version 2.0 - Read Me Notes -3



replacing the SERVER command.  Then restart (reboot) your computer.

■ Logitech ANSEL Version 1.1.  To install Logitech ANSEL Version 1.1, ensure that 
Program Manager is running.

■ Logitech Mouse Drivers.  Use of Logitech Mouse drivers prior to Version 6.2 can cause 
your system to lock if you attempt to run Windows in 386-enhanced mode while using PC
Tools for Windows options for delete protection.  To avoid this problem, upgrade to driver 
Version 6.2 or later. For information on the latest driver versions, contact Logitech, Inc. 
Customer Support. Also, using older versions of the Logitech mouse drivers along with 
VSafe and Data Monitor might result in your system being unable to start (boot). See the 
following paragraph for more information about memory-resident program conflicts.

■ Version 9 Microsoft Mouse Drivers.  There are incompatibilities with the advanced 
features of this mouse driver.  The Zoom box window might become visible when you 
switch between Desktops.  The mouse may jump erratically when the Snap-To feature is 
enabled.

■ Media Vision.  March 1993 drivers of this product can General Protection faults when 
exiting from Windows.  If you experience a problem, contact Media Vision Technical 
Support for information on newer versions of their drivers.

■ Memory-Resident Programs.  Some memory-resident programs might conflict with 
each other causing your system not to start (boot). If you experience problems, remove 
all memory-resident programs from your AUTOEXEC.BAT and CONFIG.SYS files one at 
a time until you locate the source of conflict. For more information on troubleshooting, 
see your DOS documentation.

■ Micro Cookbook 4.0.  If you intend to use Micro Cookbook Version 4 with Desktop, run 
CB40.EXE instead of COOKBOOK.EXE.

■ MS-DOS 6 Multiple Configurations.  If you are using the multiple configuration features 
of MS-DOS Version 6, you should examine your AUTOEXEC.BAT and CONFIG.SYS files
to make sure that the changes PC Tools for Windows has made to these files will be 
available for all configurations. For information about configuring this feature, refer to your
MS-DOS Version 6 documentation.

■ Printer Software Accelerator Drivers.  Printing from within System Consultant is not 
compatible with some printer accelerator drivers.  If you experience problems, use a non-
accelerated driver to print from System Consultant.  For information on newer drivers, 
contact the manufacturer.

■ Quattro Pro for Windows.  Additions to the System Control menu are not supported by 
Quattro Pro.  Therefore, the Launch List and Tag Along functions do not appear in 
Quattro Pro's System Control menu.  For information on newer versions, contact Borland 
International, Inc. Technical Support.

■ Quicken Version 1 for Windows.  When PC Tools Desktop is used as the Windows 
shell, Quicken Version 1 does not install completely.  Intuit is aware of this problem.  To 
install Quicken Version 1, use the Windows Program Manager as the shell, then change 
back to Desktop as the shell, and add the Quicken program group manually.  This 
problem does not occur with Quicken Version 2.  For information on getting Quicken 
Version 2 or newer versions, contact Intuit Technical Support.
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■ TrueType Fonts.  Some TrueType fonts can cause display problems or application errors
in any Windows application.  If you experience problems, switch to a different TrueType 
font.  For information on newer font versions that might fix these problems, contact the 
font manufacturer's Technical Support group.

■ WindowMaker.  This application is not compatible with PC Tools for Windows and 
frequently causes the system to hang.  If this happens, disable WindowMaker and add 
the applications you want to access easily to the Quick Launch folder in PC Tools 
Desktop.  Quick Launch is a powerful, easy-to-use alternative to WindowMaker.

■ WinFax Pro 3.  When performing an Optical Character Recognition (OCR) scan on an 
incoming FAX, using either the Windows Program Manager or PC Tools Desktop, you 
might see the message, "Trying to find text on the page."  The cursor then changes to an 
hourglass, the system locks, and pressing Ctrl-Alt-Del displays a DOS prompt.  Central 
Point has also received reports of this problem from users who were not performing an 
OCR scan. For information on newer versions of WinFax Pro that might fix this problem, 
contact Delrina Technology Inc. Technical Support.

■ Wired for Sound Pro.  This product can cause system instabilities if run without Program
Manager.  If you want to use Desktop as your shell, make sure you include Program 
Manager (PROGMAN.EXE) in your Startup folder to load prior to Wired For Sound.  If 
you experience problems, disable Wired for Sound.  For information on newer versions of
Wired for Sound that may fix this problem, contact ArtistoSoft Technical Support.

Documentation Notes

■ Updates to Central Point Anti-Virus.  A free virus update for Central Point Anti-Virus is 
not included with your PC Tools for Windows purchase. As new viruses are discovered, 
signatures that allow Central Point Anti-Virus to detect them are posted on the Central 
Point Software Bulletin Board System (BBS) (503) 690-6650 8,n,1. Send in your 
registration card to ensure that you receive notification when new versions of Central 
Point Anti-Virus are available.

Build Emergency Disk

■ DR DOS 6 and SuperStor.   If you use this operating system/disk-compression 
combination and drives are being swapped, type this command-line option when using 
Build Emergency Disk:

 WNEDSK.EXE/BOOT_DEV=C   

This option tells the Build Emergency Disk application where to locate the 
SSTORDRV.SYS driver and system files.  

■ Ensuring that Files are Added to the Emergency Disk.  Always specify system drivers 
by their full path in your AUTOEXEC.BAT file.  If you use a CD command to change 
directories and then specify the driver on a separate line, the Build Emergency Disk 
program does not add the driver to your emergency disk.  For example, if your 
AUTOEXEC.BAT file specifies a driver like this:

CD \MOUSE
MOUSE.COM

then the MOUSE.COM driver is not included on your emergency disk unless the MOUSE 
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directory is specified in the current PATH statement.  To ensure that the driver is included 
on your emergency disk, edit the AUTOEXEC.BAT file to specify the full path of the driver
like this:

C:\MOUSE\MOUSE.COM  

■ Adding New Drivers.  To add new drivers to Emergency Disk, add the following line to 
the [EmergencyDisk.Drivers] section of your WNUSER.INI file (You might need to create 
this section):

DRIVER.EXT=descriptive text

Example:

DRIVER.EXT=User-configurable entry that adds new drivers to the user's emergency 
disk when the emergency disk is created. Entries in this section expand Emergency 
Disk's internal table of drivers. If the emergency disk encounters one of the files from this 
section in a user's AUTOEXEC.BAT or CONFIG.SYS file, it recognizes the file, adds it to 
the Settings dialog box, and copies it to the emergency disk.

■ Help Files.   Help for the DOS utilities contained on the emergency disk is only available 
if there is enough space on the disk for the files.

■ High Memory Loaders Other than RAMBoost, EMM386, QEMM, or 386Max.  If you 
are using a high memory loader other than these, Build Emergency Disk might not find or
copy your drivers and System Consultant might not report the upper memory blocks 
(UMBs) in its DOS Memory Map topic.  If this happens, copy the necessary disk-
compression or partition drivers manually to the emergency disk. 

■ Using SCSI Controllers with Build Emergency Disk.  See "Using SCSI Controllers 
with DiskFix" in the DiskFix section of this document for important information.

Central Point Anti-Virus

■ VSafe and Windows Startup Files.  If VSafe is active and detects that any Windows 
startup files (such as KRNL386.EXE) have changed, it beeps and displays a dialog box 
when the system is "in between" DOS and Windows.  Because the system is loading 
Windows, you cannot respond to the dialog box and you might not be able to see it.  To 
correct the problem, delete the SMARTCHK.CPS file from the \WINDOWS and \
WINDOWS\SYSTEM directories, then start Windows and use Central Point Anti-Virus to 
scan the drive and recreate the SMARTCHK.CPS file.

■ LANtastic Version 5 Server.  Due to a limitation with LANtastic and LAN Server, you 
cannot scan local drives if you are running Anti-Virus on the server. If this happens, map 
the local drives as net drives and scan them from the server. 

■ Windows for Workgroups Version 3.11 and 32-bit File Access.  You cannot run Anti-
Stealth if you are using Windows for Workgroups Version 3.11 and have 32-bit file access
enabled in the control panel.

■ Banyan Vines Network.  If you are using VSAFE and VWATCH with Banyan Vines 
drivers, VSAFE and VWATCH must be loaded after Banyan vines drivers.
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■ File Formats Scanned.  In addition to the file formats documented in the manual, 
Central Point Anti-Virus scans files compressed with the PKLITE and LZEXE file-
compression utilities.

Central Point Backup

■ Passwords and Previous Versions of Backup.  If you use backup sets with 
password

protection from previous versions of Backup for DOS (Versions 7 - 8), you might need to
use the /V8PASS command-line option, as follows:

C:\CPS\WNBACKUP.EXE /V8PASS

If you attempt to use a password-protected backup set from a previous version of 
Central Point Backup for DOS without this option, the password might not be 

accepted, even if you entered it correctly.  Due to the changes in the way Central Point 
Backup for

Windows stores backup set passwords, it is not compatible with previous versions of
Central Point Backup for Windows or DOS.

If a password is used, you might not be able to restore previous versions of Backup
because the password might not be recognized. Even if no password is used, 

previous
versions prompt for a password when trying to restore the backup set. If using 

Central
Point Backup for Windows Version 7.x, enter eight spaces for the password. If using
Central Point Backup for DOS Version 7.x or 8.0x, press ENTER at the password

■ Adaptec 1542C Adapter Cards.  If you change the default configuration options for
Adaptec 1542C adapter cards, Backup might have problems accessing your SCSI 

tape
drive.  If so, run the Adaptec setup application to reset the card to the factory default
settings.  (For more information on using Adaptec SCSI cards with Backup, see the
ADAPTEC.TXT file in \CPS\DATA and the section on configuring SCSI tape drives in 

the
PC Tools for Windows manual.)

■ Windows for Workgroups Installation.  If the PC Tools for Windows CPBVXD.386
and VOPTD.386 files are installed on a remote Windows for Workgroups volume, the
volume's drive letter does not appear when you start Windows.  This is because the 

drive letter is not valid until you log in and Windows for Workgroups cannot load 
the files.  If you experience this problem, move these files to your local drive and edit 
the [386Enh] section of the SYSTEM.INI file to reflect the new location.

■ QEMM Memory Manager 386.  If you experience system problems using QEMM 
with

Backup, add this line to your command line:

DMA=xxx      where xxx>64

■ Avoiding Interruptions during Scheduled Backups.  To prevent Backup from
interrupting a scheduled backup to display miscompare warnings ("Media Verification
Warning"), edit the WNUSER.INI file (in the \CPS\DATA directory) by changing the
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SCHEDWARN= line in the [wnbackup] section to SCHEDWARN=0. (This setting
suppresses the error message dialog box during scheduled backups.)

Backup cannot back up open files, and it displays a warning message if it encounters
them during a backup.  There are two ways to avoid this interruption:

■  Choose the Program Options command, select the Advanced tab, and then choose
      "Skip without Warning."

■  If you find that several files are always open, you can exclude them from your
      backups by adding their names to the file filter list as excluded files.�

          To prevent Backup from prompting to erase or overwrite the backup media, choose
     Program Options from the Options menu and turn off "Warn Before Overwriting     
     Backup Media."

■ Using Backup while Screen Savers Are Running.  Some screen savers, including
those provided by PC Tools for Windows and Berkeley System's After Dark, can 

cause
Backup to fail during a backup or restore.  To avoid conflicts during Backup 

operations,
disable the screen saver.

■ Backing up to Compressed Disks.  Disable Backup's data compression feature if 
you

plan to back up to media compressed by Stacker, DoubleSpace, or similar software.
Compressing the data twice does not save space and might cause Backup to
overestimate the space provided by the target media.

■ Disappearing Floppy Disk Icons.  If Backup uses DMA when accessing a floppy 
drive

or tape drive, it temporarily disables the A and B drives on your system and removes 
the

drive icons from the desktop.  Several minutes after the backup or restore concludes,
the

drives become accessible again and return to the desktop .

■ Drive Mapping Problems.  Backup's drive mapping feature is designed for use with
Novell NetWare.  Backup might not correctly display drive mappings created by other
networks.

■ Confidence Test Problems.  A leading cause of confidence test failures is the use of
low-density floppy disks on drives that support higher density disks.  To perform a 

valid
confidence test, Backup requires that you use the highest density floppy disk 

supported
by the drive.

If you experience serious hardware errors during a test, check your configuration to 
see if SMARTDrive is loaded into high memory.  If it is, move SMARTDrive into 

conventional memory and repeat the confidence test.

Tape controllers such as the Colorado TC-15 or Mountain Mach II can have their 
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IRQs
set to values that cause system lockups under Windows.  If you experience system
lockups during confidence tests, make sure the controller's IRQ is not 2 or 9, values
which are reserved for Windows.

■ Irwin Controller Settings in CP Restore.  Central Point Restore, a DOS restore 
utility,

provides incorrect default settings for Irwin controllers.  The correct default settings 
are

370-6-2.

■ Mach II Data Transfer Rates.  Backup does not support the 1 MB data rates 
featured on

newer 16-bit Mach II controllers.  Backup uses a maximum transfer rate of 500 K with
these controllers.

■ Compatibility with Colorado Jumbo 4.x Backups.  Backups made by Colorado's
Jumbo 4.x software might not be readable by Central Point Backup.  If you need to
interchange tapes between backup programs, use Version 3.x of the Jumbo program.

■ Support of NetWare 4.x.  CPBackup is not a total network backup solution.  This 
version of CPBackup does not support NetWare 4.x.  It can be used to backup 

Netware Bindery and Trustee information although there is some network information 
which may not be fullyrestored.  For further details, please refer to document  # 
30037 available from our FaxBackservice.   Document 30037.TXT can also 
be downloaded from any of our online services.  Refer to the back cover of your 
PC Tools for Windows manual for information on contacting our various online 
services.

Desktop

■ Error when Exiting from Desktop.  If you are using Pro Audio Studio Video drivers 
dated 3/23/93, and Desktop is your shell, you might see an error when you exit from 
Windows.   

■ Icon Cache.  You can increase the size of the icon cache to speed Desktop's 
performance.   Edit the WNUSER.INI file (in the \CPS\DATA directory) to add the 
following lines:

[Desktop.IconCache]
NumberOfElements=xxx

Where xxx is the maximum number of icons allowed in icon cache.  If xxx is zero (0), the 
icon cache is disabled.  Icon cache sizes are:

minimum...........64
default.............256
maximum......4096

■ Installing Applications on Read-Only Desktops.  Applications cannot be installed on 
desktops that are assigned read-only access or that have the create items or folder rights
turned off.  If you install an application on a desktop with these attributes, you might 
receive a message saying the installation failed, although not all applications will warn 
you of the problem.
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■ Colorado Memory System Backup.  To install Colorado Memory System Backup, 
ensure Progman is running as the shell.

■ Borland C++ 4.0.  To install Borland C++ 4.0, ensure Progman is running as the shell. 

■ Win CIM 1.1.  The toolbar in Win CIM 1.1 will not operate properly unless you disable the
desktop menu from the Options->Advanced Settings dialog box.

■ Origin FX.  Origin FX screen saver is not compatible with Desktop.  You may experience 
problems running this screen saver with Desktop.

■ Desktop Title Bar.  One section only of the Desktop Title Bar can provide the desktop 
name pull-down menu.   

■ Object Linking and Embedding (OLE).  To use OLE between any two applications, the 
applications must be active on the same desktop.  

■ "One of the office files (*.ofc, *.hep) is damaged" Message.  This message indicates 
that the Desktop database is corrupt.  This can occur if an application fails with a General
Protection fault and forces Windows to quit.  

■ Opening an Office from a Floppy Disk.  You cannot open an office from a floppy disk.  
To use an office stored on a floppy disk, copy the files to a hard disk or network drive and 
open it from there. 

■ Desktop Properties Changes.  The Properties of a closed Desktop cannot be changed.
If you attempt to change the Properties of a closed Desktop, the Properties dialog box will
appear, however. After choosing OK, the changes will be discarded.

■ Folder Items.  The placement of items in a folder might be invisible if the items are 
dropped below the folder menu.  Choose Straighten Up or Arrange Icons from the Folder 
menu to rearrange the items correctly in a folder.

■ Using After Dark with Desktop Screen Saver Hot Spot.  The desktop screen saver hot
and cold spot might conflict with the After Dark runner. If you encounter a problem, 
disable the desktop screen saver hot spot in the Options->Advanced Settings dialog.

■ Communications Software.  If you encounter communications software difficulties 
running Communications-based applications under Desktop, you might try to improve 
communications performance by:

- Increasing the value of COMBoostTime=milliseconds (default=2) in your system.ini file 
in the [386Enh] section.

- Adding COMxProtocol=XOFF (where x is the number of your communications port, 1-   
4) to your system.ini file in the [386Enh] section.  NOTE  This setting may prevent binary 
transfers.

- Setting COMxBuffer=### (where x is the number of your communications port, 1-4, and 
### is the number of characters to buffer, default=128) in your system.ini file in the 
[386Enh] section.

- Increasing the value of the DOS background portion of the WinTimeSlice=win,dos 
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(default=100, 50) setting in your system.ini file in the [386Enh] section.

DiskFix

■ AMI BIOS Version 05/05/91.  This BIOS version prevents DiskFix from restoring the 
CMOS.  For information on later BIOS versions from AMI, contact your computer 
manufacturer's Technical Support group.

■ Compaticard Controllers.  DiskFix does not support analysis of 2.88 MB drives when 
this controller is used. 

■ Using SCSI Controllers with DiskFix.  Some SCSI Bus Mastering hard disk controllers 
do not work properly with some popular memory managers such as QEMM, 386MAX, 
and Windows Version 3.1.  If you experience problems, Microsoft recommends using 
their SMARTDRV disk cache with the double buffering option enabled.  To enable this 
option, add the following line to your CONFIG.SYS file:

DEVICE=C:\WINDOWS\SMARTDRV /DOUBLE_BUFFER

In most cases, this fixes the problem.  However, Central Point has found a few cases 
where SCSI hard disk controllers cause data loss even when SMARTDRV is used with 
double buffering.  For example, the UltraStor 14F Bus Mastering Controller appears to 
work properly with all programs, except those that access the hard disk directly, using 
DPMI services to simulate BIOS Int 13 reads and writes.  DiskFix and Build Emergency 
Disk both access the hard disk in this manner.  Under these conditions, DiskFix reports 
damaged partition information and Build Emergency Disk displays a message saying it 
cannot save partition table information.

You can correct this problem with the UltraStor 14F so that programs, such as DiskFix 
and Build Emergency Disk, work correctly by adding information to the CONFIG.SYS and
SYSTEM.INI files as follows:

Add the following line to the CONFIG.SYS file:

DEVICE=USPI14.SYS   

(USPI14.SYS is a device driver supplied by UltraStor to replace the ROM BIOS 
of their controller.)

Add the following line to the [386Enh] section of the SYSTEM.INI file:

VIRTUALHDIRQ=OFF

If you are using an older Bus Mastering SCSI controller, you might experience similar 
problems.  Contact the controller's manufacturer for information on newer versions or for 
other suggestions for correcting the problem.

■ Using ScriptTools with DiskFix.  Do not run DiskFix when ScriptTools is running.  When
ScriptTools is running, it prevents DiskFix from stopping other active processes.  As a 
result, DiskFix might falsely report errors and its performance can be significantly slower. 

File Manager
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■ CD ROM Drives and the Media Change Flag.  Some CD ROM drives do not support 
the media change flag.  If File Manager does not refresh the tree or file list when you 
change a CD ROM disk and press F5, edit the WIN.INI file to add the following line to the 
[cps] section:

Compatibility=1

■ Encrypting and Decrypting Files.  The file encryption and decryption methods used by 
PC Tools for Windows are different from those used by PC Secure for DOS.  If you 
previously used PC Secure to encrypt files, use PC Secure again to decrypt them.  Then 
use PC Tools for Windows to encrypt the files for future use.

■ File Accessories  -  Running Minimized.  Setting the Window Position property to 
Minimized has no effect on file accessories located in the File Management folder on the 
PC Tools desktop.  File accessories can only be minimized after they have been opened.

■ Printing Incompatibilities.  Some applications cannot display a print dialog box when 
minimized.  Such applications will not print correctly when you use the Print command in 
PC Tools for Windows File Manager or the Print File accessory.  The symptoms might 
appear as either a General Protection fault or a blinking icon, with no resulting printed 
output.  If you experience this problem, edit the WNUSER.INI file and add your 
application to the [FileDialogs.Compatibility] section as follows:

APPNAME=1

Where APPNAME is the application's executable file name.  Do not enter the file name's 
extension.  For example, the executable file for Microsoft Excel is EXCEL.EXE.  To add 
this application to the list, the entry would be EXCEL=1.

NOTE  Entries for Microsoft Excel and PowerPoint are included in the 
[FileDialogs.Compatibility] section by default.

■ Windows File Manager and Auto-Refresh.  The Windows File Manager 
(WINFILE.EXE) does not refresh the directory or file listings automatically when used 
with PC Tools for Windows.  Press F5 to refresh the listings manually.

 
Undelete

■ Tracking Deleted Files on Compressed Stacker, SuperStor, or DoubleSpace 
Volumes. Tracker+ might not track deleted files reliably on volumes compressed 

with these programs. Use the Sentry method for compressed drives.

File Viewer

■ WinWord 6.0 and Excel 5.0.  At the time of this release, WinWord 6.0 and Excel 5.0 
viewers were unavailable.  These viewers will be made available at a later date.  Please 
check with our BBS or CompuServe for availability.  Refer to the back cover of your PC 
Tools for Windows manual for information on accessing our BBS or CompuServe.

■ CorelDRAW! Files.  File Viewer displays only the embedded bitmap, or thumbnail, in a 
CorelDRAW! file. If the file does not contain a thumbnail, File Viewer displays a box with 
a diagonal line through it.
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■ Microsoft Excel Chart Files.  File Viewer displays Excel chart files in the underlying 
spreadsheet format, not as charts. Excel interprets this spreadsheet data to display it as 
a chart and it might appear in a different order than it appears in the actual spreadsheet.

■ Encapsulated PostScript Files.  File Viewer displays the screen representation of EPS 
files, if present. This can be either TIFF or a Windows metafile. If there is no screen 
representation (TIFF or metafile), only the PostScript text is displayed.

■ Copying Vector Formats to the Clipboard.  File Viewer converts the selection to a 
bitmap, which is copied to the clipboard.

■ Raster and Vector Keyboard Selection.  File Viewer does not presently support raster 
and vector keyboard selection.

■ Painting Artifacts Possible.  During selection, it is possible to observe paint artifacts 
when highlighting text files with File Viewer.

■ Save As for Raster File.  When performing a Save As from a raster file, the progress 
indicator occasionally counts down from 100 to 0, rather than counting from 0 to 100, as it
should.

■ Selection Tool in Full Window Mode.  It is not possible to use the selection tool while in
full window mode.  To use the selection tool, return to normal mode by pressing Esc or 
double-clicking the mouse, and then perform your desire selection.

■ Clipboard Copy.  When performing a copy to the Clipboard from text, spreadsheet, or 
database files, the status bar counts from 0% to 100% twice (corresponding to the 
placement of two formats on the Clipboard:  plain text and rich text).

■ Viewing Multi-Page Spreadsheets.  Some spreadsheets (for example, Quattro Pro for 
Windows and Lotus 1-2-3) allow you to create multi-page (3-dimensional) 

spreadsheets.  File Viewer can only view the first page of a multi-page spreadsheet.

■ Quattro Pro 5.0.  File Viewer cannot view Quattro Pro 5.0 for Windows files.

Install

■ Version 1 to Version 2 Conversion.  When installing PC Tools for Windows Version 2 
over Version 1, SmartFind and Undelete are not updated if you retain a Version 1 office 
with Version 1 SmartFind and Undelete applications. 

Note  In Version 2, these applications are part of File Manager.

■ Installing Version 2 with Version 1.  Please note that if you install Version 2 and keep 
Version 1, any icon, toolbar or menu command that references Version 1 items will have 
to be manually updated to Version 2.

■ Central Point Launcher.  If you used the Central Point Launcher program prior to 
installing PC Tools for Windows, edit the WIN.INI file and remove WNLAUNCH.EXE from 
the load= line in the [windows] section.  The Quick Launch folder in Desktop replaces 
Central Point Launcher. 

■ Previous Versions of Central Point Scheduler.  If you have an older version of Central 
Point Scheduler, replace it with the PC Tools for Windows Scheduler.  Make sure the 
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load= line in the WIN.INI file specifies the correct path to the WNSD.EXE file.  For 
example:

load=C:\CPS\WNSD.EXE

■ Removable Media.  Do not install PC Tools for Windows on removable media, such as 
Bernoulli cartridges, and then remove the cartridge from the drive.  Install copies drivers 
to the \CPS\SYSTEM directory on the installation drive and adds entries to the 
SYSTEM.INI file for these drivers, specifying the drive and path.  When Windows cannot 
find the drivers where expected, it displays an error message and might terminate.

■ Uninstall on a Network Server.  Do not uninstall PC Tools for Windows on a network 
server where client users must access server resources during an uninstall.  Uninstalling 
is an exclusive process, and your system is in a transitional state until after the required 
reboot.  By design, you cannot cancel the uninstall process after selecting applications to 
uninstall and clicking OK.  Once the uninstall process is started, attempts to halt the 
process can jeopardize system integrity.

■ VSafe and Network Installation.  If you plan to run Install with the /N parameter to install
PC Tools for Windows on a remote network drive where VSafe is also running remotely, 
first disable VSafe on the remote machine.  If VSafe is active on the remote machine, it 
will detect the disk activity and suspend the installation process.  Use Central Point Anti-
Virus for NetWare to provide transparent virus protection on your NetWare Version 3.11 
file server.  Central Point Anti-Virus for NetWare protects your file server, without requiring
users to run VSafe.

■ Deleting items from Program Manager Groups and Desktop.  Whenever an item is 
deleted from Program Manager Group and the Desktops, for example uninstalling a 
single utility, the item is not deleted.

■ Installing with Virus Protection.  If you install with virus protection active, you might 
receive false warnings.

■ AUTOEXEC.BAT files after Uninstall.  After you uninstall, you might have old versions 
of AUTOEXEC.BAT file on your system.

■ Shared Viewer Executables.  After installation, shared viewer executables are installed 
even if you haven't specified any viewers.

■ CPS Entry in WIN.INI File.  You might see a cps entry in your WIN.INI file.  Please 
ignore these entries.

■ Custom Installation with Shared Executables.  Install will fail if you perform a custom 
installation with shared executables, and there is no disk space for the private data 
directory.

■ Sharing Windows on the Network.  If you are sharing Windows executable files and 
you install the SCSI backup option, you need to manually copy VASPID.386 and 
WINASPI.DLL to the \WINDOWS\SYSTEM directory.  Write access to this directory is 
blocked if you do not have adequate directory rights and you will receive an error 
message if the files are not already in the directory.

■ Failures in Install.  If the install program terminates for any reason before it begins to 
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copy files:

1.  Exit Windows.
2.  Delete ~pctw.dir from your \WINDOWS directory (this is a temporary subdirectory        

created by Install).
3.  Restart Windows and run Install again.
4.  If the problem persists, disable any Anti_Virus TSRs.
5.  Reboot your system and delete the temporary subdirectory ~pctw.dir.
6.  Run Install (after installation, re-enable the Anti-Virus TSRs).

Manual

■ Error with Backup Command Line Option.  Page 362 of the PC Tools for Windows 
manual has an error in the command line option example to select a 1.44MB drive.  The 
correct example is /DRIVE=A:1440.

Optimizer

■ Optimizer Might Not Optimize 100%.  Optimizer does not move files that are hidden or 
open during optimization.  Since Windows and PC Tools for Windows both keep files 
open at all times, the percentage of fragmentation after running Optimizer might be 
higher than zero.  In addition, Optimizer does not move or sort directories containing 
open files during the optimization process.

■ Screen Savers.  If a screen saver is activated during an optimization process, it might 
write to a file on the hard disk to swap the active process.  When this occurs, the 
optimization process stops because of the disk access.  When you use Optimizer in 
Continuous Mode and it is interrupted by a screen saver's disk access, it restarts the 
optimization process automatically.  For this reason, use Continuous Mode.

■ Optimizer File Support.  The Optimization process supports a maximum of 32,767 files. 

■ QEMM 7.x.  If you using QEMM 7.x with disk buffering turned off, you may experience 
problems using Optimizer with DoubleSpace volumes.

Screen Capture

■ Active DOS Windows.  Screen captures cannot take place if an open or minimized DOS
window is active.

ScriptTools

■ ScriptTools Version 1 DLLs and Window Classes.  If you are using scripts written 
using ScriptTools Version 1 that refer to Central Point DLLs or window classes, you will 
have to update the scripts to include Version 2 class names.  For example, Folder 
Window is now defined as WNOM_CPS2_FolderControl1 instead of 
WNOM_CPS_FolderControl1.  Many DLLs include a version, such as WNCPS1.DLL and 
must be modified in the same fashion.  These modifications should prevent "library 
doesn't exist" or "window doesn't exist" errors. 

■ Beep Command.  On some systems, the ScriptTools Beep command might result in a 
clicking sound played on the system speaker instead of a tone.  This is generally caused 
when another application accesses the speaker and does not release the channel.  To 
correct the problem, exit from Windows, restart (reboot) your computer, and start 
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Windows again.

■ Create Recording Session Facility.  The create recording session facility has two 
known limitations:

1.   Create Recording Session records the entire window name as a single Attach string. 
This command cannot distinguish the fixed from the variable portion of the string.  To 
generalize an Attach reference, you must edit the generated script and delete the 
variable portion of the Attach string.  For example, an original Attach statement might 
be:

Attach "WINFILE_File Manager - [C:\ABEL\DOCS\*.DOC]1",1

     To generalize the reference so the script will work correctly when you view another 
drive or directory in the File Manager, change the string to:

Attach "WINFILE_File Manager",0

2.   Learn does not record actions performed on the number format combo box on 
Microsoft Excel toolbars.  To record number format actions with the Learn facility, 
choose Number from the Format menu on the menu bar.

■ Recording Movement of Desktop Items.  If you record a script that moves a desktop 
item, such as a folder icon or the icon of an application that is not running, you must edit 
the resulting script.  See "Recording a Series of Actions" in the ScriptTools online help for 
instructions.  If you do not edit the script, it will not move the item as you expected.  

System Consultant

■ Default descriptions for .INI files in WNSCDEF.RSL.  You can view additional Windows
initialization files (.INI) in System Consultant's Windows menu.  To view additional .INI 
files, add the following entry to your WNUSER.INI file:

[SystemConsultant.IniFiles]
filename.ini=filename.ini

For example:

[SystemConsultant.IniFiles]
cpav.ini=wnscdef.rsl

This entry allows you to view the Central Point Anti-Virus .INI file.  The WNSCDEF.RSL 
file contains default descriptions for .INI files.   

■ EMSNETX NetWare Driver.  System Consultant does not display valid network 
information when using this driver.  Use the NETX or XMSNETX driver instead.

■ File Tree Structures in .INI File Viewing.  The file tree structure in System 
Consultant's .INI file viewing topics is not updated correctly if sections that contain virtual 
entries are collapsed when the "Show Virtual Entries" option is enabled. You can avoid 
problems by clicking on the "Expand All" button before enabling virtual entries. If you do 
have problems, press F5 to refresh the screen.

■ 32-bit Disk Access.  If you follow a recommendation to turn 32-bit disk access on and 
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you are then unable to run Windows, change 32BitDiskAccess=on to 
32BitDiskAccess=off in your system.ini file under the [386Enh] section.

■ Control Panel Item Replacement.  If you replace a control panel item by installing a 
new product (for example, a Logitech mouse driver), the .INI-Consultant may be unable 
to use these new control panel items to edit settings in your Windows system files.

Tutorials

■ Viewing Tutorials at Higher Resolutions.  PC Tools for Windows Tutorials are designed
to be viewed on a standard VGA monitor at 640 x 480 resolution and 16 colors. Viewing 
at higher resolutions, or greater color depth, might occasionally cause items to be 
distorted or unreadable. If this occurs, consider switching to the generic 16-color VGA 
video drivers included with Windows.  (See your Windows documentation for information 
about switching video drivers.)

■ Flash and Color Palette-Switching.  When you access Tutorials, you might notice a 
brief flash, or the items on your desktop might appear momentarily with incorrect colors. 
This is particularly noticeable when using video modes that display more than 16 colors. 
The colors should be restored once you exit the tutorials. While not detrimental to the 
system, you might consider switching to the generic 16-color VGA video drivers included 
with Windows to help alleviate this behavior.

■ ATI Video Cards.  If you are using an ATI Graphics Ultra or Graphics Ultra Pro Video 
card with ATI's Mach32 driver series, some screens might appear distorted if the 

DeviceBitmaps=On is set in the [MACH] section of WIN.INI. Set this option to 
DeviceBitmaps=OFF.

■ Video drivers.  Some video drivers do not support the full range of functionality 
necessary to run the Tutorials. In particular, the driver must support the GetPixel and 
FloodFill functions. If your video driver does not support these functions, in most cases a 
dialog box will appear explaining which functions are not supported, and the Tutorial will 
not run. Contact the manufacturer of your video card or driver and ask if the latest drivers 
support these functions.

Some of the video drivers known not to support these functions are:

Diamond Stealth VRAM drivers
Microsoft 8514a SVGA drivers
Microsoft S3 drivers
Orchid Fahrenheit 1280 drivers

If the latest drivers do not provide an adequate solution, consider switching to the generic
16-color VGA video drivers included with Windows.

Removing PC Tools for Windows Manually

Install has an Uninstall feature that lets you remove PC Tools for Windows automatically.  
You can also remove PC Tools for Windows manually by following these steps.  

1.   Choose Run from File menu in either Desktop or File Manager, type SYSEDIT, and 
choose OK.
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     This program lets you edit the AUTOEXEC.BAT, CONFIG.SYS, WIN.INI, and 
SYSTEM.INI files.

2.   Select the AUTOEXEC.BAT file and delete the lines listed below.

     NOTE for Previous Central Point Software Users  If you own PC Tools for DOS 
(Version 7 - 8) or Central Point Anti-Virus, you might already have installed VSafe, 
VWatch, VDefend, Mirror, or Data Monitor.  If so, delete the lines associated with 
these products only if the line specifies the PC Tools for Windows directory (normally 
C:\CPS).  This will leave your configuration options for earlier versions of Central 
Point products intact.

C:\CPS\MIRROR C:
C:\CPS\DATAMON /SENTRY+ (or /TRACKER+)
C:\CPS\VSAFE (or VWATCH)

In addition, delete the \CPS directory from the PATH= line.

3.   Select the WIN.INI file and make the changes listed below.

In the [windows] section, delete the following from the Load= line:

C:\CPS\WNSD.EXE

To use a previous version of Scheduler (PC Tools Version 7 - 8), replace the line 
shown above with C:\PCTOOLS\WNSCHEDL.EXE.

C:\CPS\WNTSRMAN.EXE

To use a previous version of TSR Manager (PC Tools Version 7 - 8), replace the line 
shown above with C:\PCTOOLS\WNTSRMAN.EXE.

In the [Extensions] section, delete the following lines:

set=c:\cps\wnbackup.exe ^.set
run=c:\cps\wnrt.exe ^.run
sct=c:\cps\wnam.exe ^.sct
ofc=c:\cps\wndt.exe ^.ofc
evt=c:\cps\wnsd.exe ^.evt
icl=c:\cps\wnie.exe ^.icl
ico=c:\cps\wnie.exe ^.ico

If you use a previous version of CP Backup for Windows (Version 7 - 7.2), change the
set= line to 

set=c:\pctools\wnbackup.exe ^.set.

In the [embedding] section, delete the line that begins:

ScriptTools=

Delete the entire [CPS] section.
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4.   In the SYSTEM.INI file, make the changes listed below.

In the [boot] section, change the shell= line to the following:

shell=progman.exe

In the [386Enh] section (if there is one), delete any of the following lines that might be
present:

device=c:\cps\system\cpbvxd.386
device=c:\cps\system\voptd.386

     Remove the semi-colon (;) and comment preceding any device drivers.  Install might 
have replaced one or more of your device drivers.  When Install does this, it places a 
semi-colon and a comment in front of the original device= line so that the driver is not
loaded and you are aware that PC Tools for Windows made the alteration.  Deleting 
the semi-colon and comment allows the driver to be loaded again when you restart 
Windows.

5.    Exit from SYSEDIT, saving the changes made to your AUTOEXEC.BAT, WIN.INI, 
and SYSTEM.INI files.

6.   Choose Run from the File menu, type REGEDIT, and choose OK.
     This opens the Registration Information Editor application.  PC Tools for Windows 

installs ScriptTools and ScriptRunner in the Windows registration database because 
they support Object Linking and Embedding (OLE).  

     Select Central Point ScriptTools and choose Delete File Type from the Edit menu.
     Select Central Point ScriptRunner and choose Delete File Type from the Edit menu.

     Choose Exit from the File menu to exit from REGEDIT.

7.   Open the Control Panel folder, double-click the Desktop icon, and choose a non-CPS 
screen saver and wallpaper.

8.    Exit from Windows and reboot (restart) your computer, then start Windows and 
delete the PC Tools for Windows and PC Tools - WinShield groups from the Program 
Manager.

9.   Open the Windows File Manager and make the following changes:

     Delete the PC Tools for Windows directory (normally C:\CPS).

     Delete the following files from the Windows directory (normally C:\WINDOWS):

CP*.SCR
WNSSAV2.DLL
WNSSAV.HLP
CPSWALL.BMP

     If you do not have a SCSI device or do not use the ASPI device interface, delete the 
following files from the Windows system directory (normally C:\WINDOWS\SYSTEM):

WINASPI.DLL
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VASPID.386

     If you do not use the Delete Sentry feature of PC Tools for DOS (Version 7 - 8), turn 
on the option to view hidden files/directories and delete the hidden \SENTRY 
directory on each drive protected by Delete Sentry.

     If you do not use PC Tools for DOS (Version 7.1 - 8) or Central Point Anti-Virus, delete
the CHKLIST.CPS or SMARTCHK.CPS file from each directory on the disk.

10. Exit from Windows and reboot (restart) your computer.
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